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1. Introduction
Akkadian Console™ provides a complete, stable solution for companies of any size across all industries.
This flexible console is available in three deployment types: an unmanaged client, managed deployment, or
web-based deployment.
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2. 1. Requirements and Limitations
The following sections provide information and requirements your system must meet and limitations that
apply when you install or upgrade Akkadian Console.
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2.1. 1.1 System Requirements
Client hardware requirements of the Akkadian Console:

• 1 GHz Intel or AMD CPU
• 4 GB or greater RAM (8 GB Recommended)
• 16.0 GB disk space
• 100 Mbps network card
• 17-in. monitor or larger (recommended)
• Windows Small Fonts
• Windows 7 (32 and 64-bit) and above

http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851
• Akkadian Console supports multiple DN partitions

Admin Permissions are needed to the following directory for users installing Akkadian Console:

• Windows 7 and Higher:
C:\Users\\AppData\Local\akkadian Labs\akkadian Console

Supported End Devices:
Akkadian Console supports all phone models that are CTI enabled
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2.2. 1.2 Application Support
Akkadian Console provides support for the following applications:

Application Versions

Cisco Unified Communications Manager 10.x – 14.x
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2.3. 1.3 Network Requirements
Akkadian Console communicates on the following ports:

Traffic Port Direction

Application Web Access HTTPS:443 Inbound —> Akkadian Console Server

Communication to Cisco
Communications Manager

HTTPS:8443
Outbound Akkadian Console Server —>
CUCM

LDAP
TCP/UDP Ports
389/3268

Outbound Akkadian Console Server —>
LDAP Server
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3. 2. Setting up Cisco Communications
Manager
Akkadian Console requires the following versions of Cisco Communications Manager in order for the
application to operate:

• Cisco Communications Manager versions 10.x and above
• IP access to Communications Manager required
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3.1. 2.1 Required CUCM Services
Akkadian Console requires the following items to be configured in Cisco Communications Manager in order
for the application to operate:

• The Cisco AXL Web service is activated and started on all call processing nodes in the cluster.
• The Cisco CTI Manager service is activated and started on all call processing nodes in the cluster.
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3.2. 2.2 Creating CUCM Application User
To create a New CUCM Application User for use with Akkadian Console:

1. Login to CUCM using the administrative access.
2. Navigate to the User Management > Application User page and Click Add New.
3. Create a new application user. (example “aco”)

4. Scroll down to Permissions Information and click on Add to Access Control Group.
5. Add the following groups to the application user:

• Standard CTI Allow Call Monitoring
• Standard CTI Allow Call Park Monitoring
• Standard CTI Allow Control of All Devices
• Standard CTI Allow Control of Phones Supporting Connected Xfer and Conf
• Standard CTI Enabled
• Standard TabSync User
• Standard CCM Server Monitoring (Optional for Queue Monitoring)

Click Add Selected.
Click Save at the bottom of the page when finished

Akkadian Labs Akkadian Console Admin Guide - 4.9_en

Page 8 of 49



3.3. 2.3 Setting up Emergency Service

To setup CER in Call Manager please follow the instruction below.

Step 1 : Enable Emergency Call Handler

Step 2: Configure Emergency Location Groups

Step 3: Add a Device Pool to an Emergency Location Group

This configuration is optional, Please setup your CER if you are planning to use Emergency
Service in Console.

!
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Step 4: (Optional) Add Device to an Emergency Location
Group

Step 5: Enable Route Patterns and Translation Patterns
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https://www.cisco.com/c/en/us/td/docs/voice_ip_comm/cucm/admin/11_5_1/featureConfig/
CUCM_BK_C7DC69D3_00_cucm-feature-configuration-guide_115/CUCM_BK_C7DC69D3_00_cucm-
feature-configuration-guide_115_chapter_0110000.html

for more information please follow the CISCO documentation*
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4. 3. Installation & Setup
The first time Akkadian Console is started, it will run the Akkadian Console Setup Wizard to gather
information required to integrate with Cisco Communications Manager. This section requires information
from the Setting up Cisco Communications Manager section and should be completed by a system
administrator

To install Akkadian Console:

1. Download the software from the Akkadian Labs Portal.
2. Follow the prompts to install the application

3. Once completed, launch Akkadian Console by double-clicking the icon that appears on your desktop and
proceed to Section 3.1.
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4.1. 3.1 Licensing Akkadian Console
After installing Akkadian Console, you will receive a prompt to license the application.

To license Akkadian Console:

1. Enter your First Name, Last Name, and Email to receive an activation key via email

2. If you have a full or trial license key, click Continue
3. Enter your First Name, Last Name, Email, Organization and License Key
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4. Click Submit to continue

If you do not have access to import the license key from the machine, you need to generate and import an
offline license

To generate an offline license:

1. Login to the Customer Portal and select the License key
2. Click Generate License File and fill out the required fields
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3. Click Generate License and a license file will download on your machine
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4. Import the downloaded file into the console
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4.2. 3.2 Select a Language
To select a language:

1. Choose a language from the drop-down menu.

2. Select OK.
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4.3. 3.3 Importing a Configuration
Once a single copy of the Akkadian Console is configured, you can import the same configuration settings
when installing subsequent copies of the console on other machines.

Important: This step is optional. If you do not wish to import a configuration, press Skip and proceed to the
next section.

To import an existing configuration:

1. For Akkadian Console version 3.x+, browse to import the profile3.xml file and click OK.
2. To import a configuration from version 2.x, click Import FCO 2.x configuration.
3. Locate the profile.xml file and click OK.
4. If this is your first setup and you do not have an existing .XML configuration file, select Skip from the

Configuration Window to continue with a manual configuration.

Note:

• If importing from an existing configuration, the profile3.xml file is located in the C:\ProgramData\
akkadian Labs\akkadian Console folder

• If you import an existing configuration, you may need to change the monitored device. Once the
installation is complete, go into the Options menu to switch the device.
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4.4. 3.4 Management Server Settings
Akkadian Console version 4.3 and above provides an optional managed client/server model for centralized
management and reporting

Note: This step is optional. If you do not wish to manage Akkadian Console with the Console Server, click
Next to continue.
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4.5. 3.5 Cisco Unified Communications
Manager Settings
Below are the fields associated with integrating Akkadian Console with Cisco Communications
Manager:

CUCM Configuration

CUCM Server 1 Primary CUCM Server

CUCM Server 2 CUCM Server (Optional)

CUCM Server 3 Tertiary CUCM Server (Optional)

CUCM Application Username CUCM Application User for JTAPI

Confirm Password Confirm CUCM Application User Password

AXL Configuration

AXL Server 1 Primary CUCM Server

AXL Server 2 Secondary CUCM Server (Optional)

AXL Server 3 Tertiary CUCM Server (Optional)

AXL Application Username: CUCM Application User for JTAPI

AXL Application Password: CUCM Application User Password

Voicemail Configuration

Voicemail Transfer Prefix Prefix for voicemail transfer pattern

Voicemail Pilot Number Voicemail pilot number

Allowed Parking Partitions Searchable CUCM Park Partitions

Partition Configuration

Allowed Partitions Searchable CUCM Partitions for Directories

To integrate Akkadian Console with Cisco Communications Manager:

1. Fill out all required fields marked in red in the following windows.
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2. Click Next to continue.
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4.6. 3.6 Device Settings
Akkadian Console supports all phone models that are CTI enabled

To monitor a device in Akkadian Console:

1. Enter the extension of the device you would like to monitor
2. Click the Search button to locate the MAC address of the phone(s) associated with the extension.
3. From the Choose device field, use the drop-down menu to select the appropriate MAC address of the

device you wish to control.

4. Click Next to continue
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4.7. 3.7 Dial Rules Configuration
Dial Rules manipulate the number dialed based on the rule created.

For example, an external telephone number in the Directory, Speed Dial, or International Number can be
10 or more digits, but a prefix of 9 or 9 and a country code is needed to make external calls.

Note: Both Dial Rules and Directory Rules support the use of RegEx for greater flexibility. This is initiated
when the end-user enables the “Apply after removing non-digits” check box.

Below are the fields associated with creating Dial Rules in Akkadian Console.

Name Populate the Name field with a descriptive name for the dial rule.

Begins With
Use this to specify which numbers the rule will apply to by matching the starting digits from
left to right.

Length
Use this field to apply rules based on the length of the number. All characters including
dashes, plus signs and numbers are counted in the length field.

Number of Front
Digits to Remove

Strip digits from a number matched by a Dial Rule. Digits are removed from left to right.

Applied Prefix
Populate this field to prefix digits on numbers matching a Dial Rule. The Applied Prefix
occurs subsequent to the Digits Removed function.

Ignore
Characters

Populate to remove certain characters from a number.

Remove non-
digit characters

To strip all non-numeric characters from a number. This must be applied if your telephone
numbers contain non-numeric characters or the dial rules may not function properly.

To add a new Dial Rule:

1. Fill out all required fields (Test rule for International Dialing shown)
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2. Click Add and test the Dial Rule with a Sample Number. The Input Length and Digit Count should
match the Length stated in the Rule Criteria

3. Click Save
4. Click OK to confirm changes or Cancel to close

Note: This step is optional. If you do not wish to set any rule or would like to do so at a later time, click
Next.
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4.8. 3.8 Set Configuration Password
Users can log into the console using their personal credentials, while administrators can access protected
settings within the console using this Configuration Password.

Note The configuration password for Akkadian Console is saved locally to the machine
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Select Finish to complete the setup.
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4.9. 3.8 Configure Emergency Service
Multiple emergency number can be setup to monitor emergency calls. Please follow the steps to
configure Emergency service.
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5. 4. Application Control Menu
The Akkadian Console Application Control Menu provides additional methods to customize the Akkadian
Console interface.

The Application Control Menu consists of the following components:

Preferences Modify various user settings

Options Access protected console configuration settings

Updates Check for console updates

View Toggle between different layouts or restore hidden panels

Help Access documentation and gather logs to assist with troubleshooting

Exit Close the Application

The Application Control Menu can be accessed by clicking on the icon located in the upper right-hand
corner of the application
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5.1. 4.1 Preferences
Preferences can be used to modify the following settings:

Font Size Use the drop-down arrow to choose between sizes 10-18 font.

Font Style Use the drop-down arrow to choose between Normal and Bold.

Language Use the drop-down arrow to choose between English, Spanish and French.

Theme
Use the drop-down arrow to choose between Default, Expression Dark, or High
Contrast.

Search Behavior Use the drop-down arrow to choose between Start with and Contains.

Shortcut Keys Define the keyboard shortcuts aCO will use to perform call control tasks

Launch on Startup Launch the console after logging into the machine

Enable Directory
Filter

Select a default department for directory search

Enable Legacy
Search

Changes the directory to search by First Name, Last Name, and Number

To access Preferences in Akkadian console:

1. Click the icon and go to Preferences.
2. Adjust the desired setting.
3. Press the OK button to confirm changes or press the Cancel button to close the preferences window.
4. To reset all changes to default, click the Restore default button.
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5.2. 4.2 Options
The Options allow admins to access protected console configuration settings.

Admin or Read & Execute Permissions are needed to the following directory for users updating
Akkadian Console via the Options Menu:

• Windows 7 and Higher:
C:\ProgramData\akkadian Labs\akkadian Console

To access Options in Akkadian console:

1. Click the icon and go to Options.
2. Enter the Configuration Password

3. Press OK to continue.

If you do not know or forgot the configuration password, click Forgot your password to access the
Password Reset window to create a new configuration password
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Please refer to the Installation & Setup section for more information on the following sections also located
in the Options:

• Management Server
• CUCM
• Device
• Dial Rules
• Options Permission
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5.2.1. 4.2.1 Directory Source
Akkadian Console supports multiple Directory Sources with CUCM as the default. The Directory Source
populates all users and directory numbers based on the CUCM end-user database.

Below are the following sources that can be integrated with Akkadian Console:

CUCM Default. No additional configuration required.

CSV File Select desired CSV file and Map the Directory

Remote CSV File Specify the remote CSV location and Map the Directory

LDAP
Choose the Authentication Method and configure the options applicable to your
environment.

MySQL Enter the Connection String and configure the options applicable to your environment.

Microsoft SQL
Server

Enter the Connection String and configure the options applicable to your environment.
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UDS Enter the User Data Source URL and Field Mapping according to your environment

Click OK to confirm changes or Cancel to close
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5.2.2. 4.2.2 Directory Rules
Directory Rules provide presence status to directory numbers that do not match the extension in Cisco
Communications Manager.

For example, a user’s telephone number in the directory may be the full E.164, but the actual extension in
CUCM could be a shortened 5 digit extension. Directory Rules can be used to map the directory number to
the extension to provide valid presence status.

Note: This step is optional. If you do not need to configure Directory Rules or would like to do so at a later
time, click Cancel.

Please Refer to the Dial Rules Configuration section to review fields associated with creating
Directory Rules in Akkadian Console.

To add a new Directory Rule:

1. Click the icon and go to Options.
2. Enter the Configuration Password
3. Select Directory Rules
4. Fill out all required fields (E.164 to 5 digit conversion shown)
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5. Click Add and test the Directory Rule with a sample number. The Input Length and Digit Count
should match the Length stated in the Rule Criteria

6. Click Save
7. Click OK to confirm changes or Cancel to close
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5.2.3. 4.2.3 Microsoft Exchange
Akkadian Console can integrate with a Microsoft Exchange to display a user’s calendar status.

In order for the Microsoft Exchange feature to operate the following items must be enabled:

• Microsoft Exchange Service Account being used has a Primary SMTP E-Mail address
• Microsoft Exchange Server has the Autodiscover Service enabled, for auto discover

Note: This step is optional. If you do not wish to integrate Akkadian Console with Microsoft Exchange,
select Cancel.

Below are the fields associated with configuring Microsoft Exchange:

Exchange URL Enter the Exchange web services URL or click Discover URL

User ID Enter the user ID for an account with access to all Calendar Data

Password Enter the password for the account

Exchange Version Select the appropriate Exchange version

To configure Microsoft Exchange:

1. Click the icon and go to Options.
2. Enter the Configuration Password
3. Select Microsoft Exchange
4. Enter the Exchange Server information
5. Click Validate to verify connectivity.
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6. Press OK to confirm changes or press Cancel to close
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5.2.4. 4.2.4 Queue
The Queue Settings in Akkadian Console displays Hunt Group statistics within the Console Interface.

Note: This step is optional. If you do not need to configure Queue Settings or would like to do so at a later
time, click Cancel.

Akkadian Console requires the following items to be configured for the Queue Settings to operate:

• CUCM 10.x or higher
• The Cisco Real Time Monitoring Tool (RTMT) service activated
• The Hunt Group must have call queuing enabled

Below are the fields associated with creating the Queue Settings in Akkadian Console:

Service URL
URL to the current CUCM server. The server URL should reflect the following format:
https://CUCM IP Address:8443/perfmonservice/services/PerfmonPort

Username Enter the application username created in Call Manager

Password Enter the application password created in Call Manager

Hunt Pilot Numbers Enter the pilot numbers configured in Call Manager

To configure Queue Settings in Akkadian Console:

1. Click the icon and go to Options.
2. Enter the Configuration Password
3. Select Queue
4. Fill out all fields for Queue Settings. Hunt Pilot numbers should be separated by a comma (,).
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5. Click OK to confirm changes or Cancel to close

Note: Akkadian Console Operator does not validate Hunt Pilot numbers. Please ensure the
Hunt Pilot numbers entered are valid within CUCM.*
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5.2.5. 4.2.6 Parameters
Below are the fields associated with modifying Parameters:

AXL Request
Chunk Size

The amount of returned rows per one AXL request. for example: if the chunk size is 100 and
response contains 240 rows, the application receives 3 responses: 100 rows + 100 rows + 40
rows.

Displayed
Speed Dials
Limit

Maximum amount of speed dial items in the speed dial panel.

Displayed
Directories Limit

Maximum amount of directory items in the directory dial panel.

Displayed Call
History Limit

Maximum amount of call history items in the call history panel.

Parked Call
Warning After
(Sec)

Time span before the parked calls highlight becomes yellow.

Parked Call
Error After
(Sec)

Time span before the parked calls highlight becomes red.

Notes Retention
Time (Sec)

When expired, this timer will remove notes from parked calls and active calls

Call Hold Time
Warning After
(Sec)

Time span before the warning color for calls on hold turns orange

Call Hold Time
Error After
(Sec)

Time span before the warning color for calls on hold turns red

Application
Auto-Focus

Places the console to the forefront when a call is made to any monitored line.

Enable Debug
Logging

Console client will be running in Debug Mode

Disable HLOG
button

Removes the HLOG button from the application interface

Enable device
selection

Select preferred monitored device after logging in
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Enable
Enhanced Blind
Transfer

An enhanced transfer that mimics the device transfer

Use Cached
Directory

For faster loading, the console reads the Directory Cache file on launch

Use Cached
Device List

For faster loading, the console reads the Device Cache file on launch

To access Parameters in Akkadian console:

1. Click the icon and go to Options.
2. Enter the Configuration Password
3. Select Parameters.
4. Adjust the desired settings.

5. Click OK to confirm changes or Cancel to close
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5.3. 4.3 Updates
The Updates allow users or admins to update the console to the latest version

To check for updates in Akkadian Console:

1. Click on the icon in the upper right-hand corner of the application.
2. Select Updates.

3. If an update is available, click Update to install. If no update is available, click Close to return to the
application.
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5.4. 4.4 View
The View menu allows you to quickly toggle the application between different layouts as well as restore
hidden panels.

The View menu provides three different options:

Layout Change the application panel layout

Panels Used to restore hidden panels

Window Reset the application Window to the default size
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5.4.1. 4.4.1 Change the Layout
To change the layout:

1. Click the icon and go to View .
2. Select Layout.
3. Select the desired Layout.

• Vertical – Organizes the panels in a vertical format.
• Normal – Resets the panels back to default, but does not update tabs within the panels.
• Reset to Default – Resets all panels and tabs back to the default layout.
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5.4.2. 4.4.2 Restore Panels
To access the Panels menu:

1. Click the icon and go to View.
2. Select Panels.
3. Select the Panel to restore from the list.

Akkadian Labs Akkadian Console Admin Guide - 4.9_en

Page 46 of 49



5.4.3. 4.4.3 Reset Console Window
To reset the Window view:

1. Click the icon and go to View.
2. Select Window.
3. Select Reset View.
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5.5. 4.5 Help
The Help section provides access to documentation and gathers logs to assist with troubleshooting.

To access the Help menu:

1. Click the icon and go to Help.
2. Select from the following options:

• Online User Guide: Access the Akkadian Console User Guide online
• Report a Bug: This will gather all necessary log files and place them into a single .zip file on your

desktop. These files can then be emailed to support@akkadianlabs.com for analysis.
• About: View the Akkadian Console Version, link to the Product Website, End User

Documentation, Send an email for Akkadian Console Licensing as well as the Hardware and
Registered User Information.
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5.6. 4.6 Exit
To Exit Akkadian Console:

1. Click the icon and select Exit
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